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How to use the Mail Merge feature in
Word to create and to print form letters
that use the data from an Excel
worksheet

Summary

This article explains how to use the Mail Merge feature in Microsoft Ward to create and to print form letters
by using data from a Microsoft Excel worksheet.

When you use the Word Mail Merge feature, Word merges a main document with a recipient list to generate
a set of output documents:

*  The main document contains the basic text that is the same in all of the output documents. It may
contain a letterhead, text, and instructions in merge fields for inserting text (such as recipient names
and addresses) that vary from one output document to another,

» The recipient list is a database that contains the data that is to be merged into the output
documents. For example, the recipient list is a Microsoft Access database file or an Excel worksheet,

This database is typically a list of names, addresses, phone numbers, and other categories of personal
information.

»  The output documents are the result of the mail merge. The text in an cutput document can be the
same in all output documents, but you can apply formatting to specific documents

Step 1: Set Up the Excel Data File

Before you proceed with the Mail Merge Wizard, make sure that your Excel worksheet is well structured for
this purpose, MNote the following requirements far the data table:

= The first row should contain field names for each column -- for example, Title, Salutation, First Name,
Middle Mame, Last Mame, Address1, and Address2.

s Each field name should be unique.

# Each row should provide information about a particular itern. For example, in a mailing list, each row
might include information about a particular recipient.

1 The table should contain no blank rows.

Create your Excel data file, and then amange it by using the fields that you want to use for your letter, as
shown in the following sample data file.

After you create your Excel data file, save it, and then close the data file.

For more information about how to create a mail-merge address list, click the following article number to
view the article in the Microsoft Knowledge Base:

234688 How ta design and set up a mail merge address list in Word 2002 and in later versions of Word
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Step 2: Set Up the Main Document

1. In Micrasoft Office \Ward 2003 and in earlier versions of Ward, point to Letters and Mailings on the
Tools menuy, and then click Mail Merge Wizard.

In Microsoft Office Word 2007, dick Start Mail Merge in the Start Mail Merge group on the Mailings
tab, and then click Step by Step by Mail Merge Wizard.

2. Under Select document type, click Letters.
The active decument becames the main document. The main document contains the text and
graphics that are the same for each version of the merged document. For example, the return
address and the salutation in a form letter are the same for each version.

3. Click Mext: Starting document.

4, Use one of the following methods:

= Start with the document that is currently shown in the dacument window, To do this, click
Use the current document.

You can then either type the letter in the document window or wait until the wizard prompts
you to do sa in a later step.

= Start with a template. To do this, follow these steps:

. Click Start from a template.

i. Click Select template.

ii. On the Mail Merge tab, select the template that you want in the Select Template dialog box,

and then click OK.

= Start with an existing document. To do this, follow these steps:

. Click Start from existing document.

i. In the Start from existing box, select the document that you want, and then click Open.

. If you do not see the document, click More files, and then click Open. In the Open dialog
box, locate the document that you want, and then click Open.

5. Click Next: Select recipients.

Step 3: Specify the Excel Data Source

1. Under Select recipients, click Use an existing list.

2. Click Browse.

3. In the Selact Data Source dialog box, locate and then click the Excel worksheet that you want to use.
By default, Word opens the “My Data Sources” folder.

4, Click Open,

5 If your Excel warkshest contains information about multiple tabs, select the tab that contains the
infarmation that you want, and then click OK

6. All entries in the data source appear in the Mail Merge Recipients dialog box. Here, you can refine
the list of recipients ta include in the merge.
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Step 4: Select the Recipients

1. In the Mail Merge Recipients dialog box, select the recipients that you want to include. To do this, use
one of the following methods;

Notes

Use the check boxes to designate recipients.

This methad is most useful if the list is short. Click to select the check boxes next ta the
recipients that you want ta include, and then click to clear the check boxes next to the
recipients that you want to exclude,

Mate If you know that you want to include maost of the list in your merge, click Select All, and
then click to clear particular records. Similarly, if you want to include only a few records in the
list, click Clear All, and then select the recards that you want.

Sort items in the list.

This method is useful if you want to see items in alphabetical or numeric order. Click the
column heading of the element by which you want to sort. For example, if you want to
display the list alphabetically by last name, click the Last Mame column heading.

Filter items in the list.

This method is useful if the list contains records that you know you do not want to see or

include in the merge. After you have filtered the list, you can use the check boxes to incude
and exclude records, as described earlier. To filter the list, follow these steps;

. Click the arrow next to the column heading of the element that you want to filter by

. Click any of the following:

s (Blanks): This option displays all the records in which the corresponding field is blank

» (Monblanks): This option displays all the records in which the corresponding field contains
information,

= |f the data source contains records that share the same information, and if there are 10 or
fewer unigue values in the column, you can filter by specific information. For example, if
there are multiple addresses that list Australia as the country, you can filter by Australia.

The Mail Merge Recipients dialog box displays only the designated records. To display all the
records again, click (All).

For advanced sorting and filtering, click the arrow next to any column name, and then dick
iAdvanced). Use the Filter Recards and Sort Records tabs to set up the sorting o filtering
guery that you want.

If you have installed address validation software, click Validate in the Mail Merge Recipients
dialog box to validate your recipients’ addresses.

2. Click OK to return to the Mail Merge Wizard.

Word uses the recipients that you designated far the merge.

3. Click Mext: Write your letter,
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Step 5: Complete the Letter and Add Merge Fields

If you have not already done this, type the text that you want to appear in every form letter in the main

document.

Insert Merge

Insert merge

Fields

fields where you want to merge names, addresses, and other information from the data source.

To insert merge fields, follow these steps:

1. In the main document, click where you want to insert the field.

2. Insert any of the following:

Address block with name, address, and other information:

i. Click Address block.

ii. In the Insert Address Block dialog box, select the address elements that you want to include
and the formats that you want, and then click OK. For help on an option, click the guestion
mark, and then click the option.

For help on an option, click the question mark, and then click the option. If the Match Fields
dialog box appears, Word may be unable to find some of the information it needs for the
address block. Click the arrow next ta

{not available), and then select the field from your data source that corresponds to the field
required for the mail merge.

®  Greeting line:
i. Click Greeting line.
i, Select the greeting line format that includes the salutation, name format, and following
punctuation.
jii. Select the text that you want to appear in the cases in which Word cannot interpret the
recipient’s name. Far example, Word cannot interpret the name when the data source
cantains no first or last name for a recipient, but only a company name,
iv. Click OK.
. If the Match Fields dialog box appears, Word may be unable to find some of the infarmation

it needs for the greeting line, Click the arrow next to (not available), and then select the field
fram your data source that corresponds to the field required for the mail merge.,

Other fields of infermation;

. Click More items,

. Use one of the following methods:
» Click Address Fields to select from address fields that will automatically map te
corresponding fields in your data source, even if the data source’s fields do not have the

same name as your felds,

# Click Database Fields to select from fields that always take data directly from a column in
a database.

In the Fields box, click the field that you want.

iv. Click Insert, and then click Close.

=

If the Match Fields dialog box appears, Word may not be able to find some of the
infarmation it needs to insert the field. Click the arrow next to (not available], and then select
the field from your data source that conesponds to the field required for the mail merge.
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Note If you insert a field frem the Database Fields list, and if you later switch to a data
source that dees not have a column with the same name, Word cannot insert that field
infarmation into the merged document.

= Electronic postage:

To add electronic postage, you must first install an electronic postage program, such as ane
that you can purchase from a third-party provider an the Web. To use electronic postage,
follow these steps:

. Click Electranic postage.

If you do not have an electronic postage program installed, Word prompts you to install one,
and offers to connect to the following Microsoft Office Web site:

Print Online Postage
http:/foffice microsoft.com/services/service aspulsid=2.4

i. Insert the postage acconding to the program's instructions,

* To add electronic postage, you must first install an electronic postage pragram, such as ane
that you can purchase from a third-party provider an the Weh. To use electronic postage,
follow these stepsPostal bar code: You must select a letter or envelope type that supports the
POSTNET bar code. To use the Postal bar code, follow these steps:

I. Click Postal Bar Code.

i. In the Insert Postal Bar Code dialog box, select the appropriate address fields.

Note The Postal Bar Code option appears anly if you are using the U 5. language version of
Word,

iii. Repeat steps a and b for all the fields that you want to insert. NOTES:

» You cannot type merge field characters (7 or insert them by using the Symbol command
on the Insert menu.

s |f the merge fields appear inside braces, such as [ MERGEFIELD City |, Word is displaying
field codes instead of field results. This does not affect the merge, but if you want to

display the results instead, right-click the field code, and then dick Toggle Field Codes on
the shortcut menw.

For example, by using the sample database shown earlier, your letter might contain the
AddressBlock and GreetingLine fields, and therefore your first page appears similar to the
fallowing:

February 26, 2002
AddressBlock
GreetingLine

Type your letter here,
Sincerely,

Type your name here

Maote You can also use the Mail Merge toolbar to insert merge fields, work with your mail -merge
main dacument, of run a mail merge. To display the Mail Merge toolbar, point to Letters and
Mailings on the Tools menu, and then click Show Mail Merge Toolbar.
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The Mail Merge toolbar provides additional commands that are not included in the Mail Merge
Wizard task panes. For example, you can use the Insert Word Field menu on the Mail Merge toolbar
to insert Word fields for controlling the merge process. For example, you can insert an IF field that
inserts text only if a particular merge field has a specified value.

Alternatively, you can click Check For Errors to make Word run the mail merge and report any errors
that are contained in the main document.

Change the Format of the Merged Data

To farmat merged data, you must format the merge fields in the main document. Do not format the data in
the data source, because its formatting is not retained when you merge the data into the decument. To
change the format of the merged data, follow these steps:

1. Inthe main decument, select the field that comains the information that you want to format,
including the enclosing merge field characters (<< >>)

2. InWord 2003 and in earlier versions of Word, click Fant on the Format menu, and then select the
options that you want.

In Word 2007, click the option that you want in the Theme Fonts box in the Font group on the Home
tab.

Format by Using Field Codes

To control other aspects of formatting, press ALT+F2 to display field codes, and then add switches to the
merge fields, When you wark with fields, a switch is a special instruction that causes a specific action to
occur. Generally, a switch is added to a field to modify a result.

Examples of how to use switches are as follows:

*  Todisplay the number 34987.89 as §34,987.80, add the Mumeric Picture switch (\#).
v To print client names in uppercase letters, add the Format switch [\*).

*  To make sure that the merged information has the same font and point size that you apply to the
merge field, add the Charformat switch (4*).

Step 6:; Save the Document

After you have completed the main document and inserted all the merge fields, make sure that you save the
document before proceeding. To do this, follow these steps:

1. In'Word 2003 and in earlier versions of Woard, click Save As on the File menu.
In Word 2007, click the Microsoft Office Button, and then click Save As.
2. Name the document, and then click Save,

3, Click Next: Preview your letters.

Step 7: Preview the Letters and Fine-Tune the Recipient List

When the wizard displays the “Step 5 Mail Merge" task pane, the wizard replaces each of the merge fields in
the main document that has the actual text from the first entry of the recipient list Therefore, you can see
how your first output document will look.

For example, if you were to continue to use the sample database shown earlier, the first page should
resemble the following page after you click Next: Preview your letters:

February 26, 2002

Andrew Fuller
908 W, Capital Way
Tacoma 98401
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Dear Andrew Fuller,

Type your letter here.

Sincerely,

Type your name here To preview additional entries, use ane of the following methods:

= To preview the items in order, click the left or right arrow buttans.

s To locate and preview a specific item, click Find a recipient, and then enter the search critena in the
Find Entry dialog box.

Fine-tune the recipient list if you want. To do this, use one of the following methods:

*  To exclude a particular recipient from the merge operation, click Exclude this recipient.

& To change the list of recipients, click Edit recipient list, and then make your changes in the Mail
Merge Recipients dialog box

Step 8: Complete the Merge

To complete the merge, use any of the following methods.

Personalize Individual Letters

To personalize individual items, you actually complete the merge, and then edit the information that you
want in the resulting merged document. To do this, follow these steps:

1. Click Edit individual letters.
2. In the Merge to Mew Document dialog box, select the records that you want to merge.
3. Click OK,

Word creates and opens a new merged document. Your main document also remains cpen, and you
can switch back to it if you want to change all the documents.

4. Scroll to the information that you want to edit, and then make your changes.

5. Print or save the document just as you would any regular doecument.

Print the Letters

To print the letters, use one of the following methods:

v |f you personalized the iterns and if the merged document is active, follow these steps:
a. InWord 2003 and in earlier versions of Word, click Print an the File menu.
In Word 2007, click the Microsoft Office Button, and then click Print.
b. Select the options that you want,
*  |f you want to print directly from the Mail Merge Wizard, follow these steps:
a. InStep & of the Mail Merge Wizard (Complete the merge), click Print,
b. Inthe Merge to Printer dialog box, use one of the following metheds, and then cick CK;:
n To print all the documents, click All
= To print the document that you see in the document window, click Current record.

= To print a range of documents, click From, and then type the record numbers in the From and
To boxes.
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€. Inthe Print dialog box, select the options that you want.

Save the Merged Letters for Later Use

If you want to edit merged letters or to save them for later use, you can collect them into a single document.
To do this, follow these steps:

1. Click Edit individual letters.

2. In the Merge to a New Document dialog box, use one of the following metheds, and then click OK:
= To merge all the documents, click All.
= To merge only the document that you see in the document window, click Current record.

= To merge arange of documents, click From, and then type the record numbers in the From
and To boxes.

3. Word opens a single new document that contains all the individual letters. You can then save the
document for later use, just as you would any regular document.
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